OPERATOR’S MANUAL

OCEAN SEVEN 307
OEM SMART LOW POWER CTD SENSORS

IDRONAUT S.r.l.
Via Monte Amiata, 10 - 20861 BRUGHERIO (MB) - ITALY
Tel. +39 039 879656 / 883832
Fax. +39 039 883382
e-mail: idronaut@idronaut.it
Http://www.idronaut.it
# Table of Contents

1. Introduction 1
   1.1. RS485 interface 1
   1.2. OEM module wiring 2
   1.3. EMC/EMI 2
   1.4. OEM module firmware 2
   1.4.1. Firmware 2
   1.4.2. Data processing 2
   1.4.3. Operations 3
2. Conductivity module 4
   2.1. Electronic specifications 4
   2.2. Physical characteristics 4
   2.3. Ground connection and shielding of the Conductivity module 4
   2.4. The seven-ring conductivity sensor 5
3. Temperature module 6
   3.1. Electronic specifications 6
   3.2. Physical characteristics 6
   3.3. The temperature sensor 7
4. Combined Pressure and temperature module 8
   4.1. Electronic specifications 8
   4.2. Physical characteristics 8
   4.3. Pressure sensor 9
   4.4. The temperature sensor 9
5. High precision pressure module 10
   5.1. Technical specifications 10
   5.2. Accuracy and Precision 10
   5.3. Polynomial Compensation 11
   5.4. Communication protocol 11
6. Installation and Start-up 12
   6.1. Installation 12
   6.2. ITERM program installation 12
   6.3. Power supply 12
   6.4. How to operate the OEM module 12
   6.4.1. Verbose vs Non-Verbose 13
   6.5. OEM module Start-up procedure 13
   6.6. Installation of OEM module in a RS485 network of sensors 13
7. OEM module COMMUNICATION PROTOCOL 14
   7.1. Command message structure 14
   7.2. Answer message structure 14
   7.3. Communication protocol commands 15
   7.4. Communication protocol mode 15
8. ITERM programme 16
   8.1. Distributed files 16
   8.2. Programme menus and functions 16
   8.3. Toolbar 18
   8.4. Start-up switches 18
9. OEM307 - Pinouts 19
IMPORTANT REMARKS

CONDUCTIVITY SENSOR

1) To obtain the best accuracy, the conductivity sensor and therefore the probe sensor head, must be immersed in clean seawater for at least 15 minutes before measurements. For fresh water application, the sensor does not require any hydration.

2) When the conductivity sensor is not in use, it is kept dry. Therefore, when the conductivity sensor is placed in water, very small bubbles may remain attached to the platinum ring electrodes (seven). If such a thing happens, the measured value of conductivity will be lower than the true one. To remove these air bubbles, degrease the inside of the conductivity cell using cotton buds wetted with liquid soap. Gently rotate the cotton bud against the whole internal surface of the quartz cell. This will wet the platinum electrodes, thus reducing the surface tension of the cell and considerably decreasing the risk of trapped air bubbles.

LIFETIME AND HOW TO REPLACE THE IDRONAUT SENSORS

The IDRONAUT sensors are all pressure compensated and, in particular, the physical sensors (temperature and conductivity) can last many years, if properly used. They are high-quality sensors, as they are well known by oceanographers to measure salinity with great accuracy. The wire sensors are tin soldered on their respective connection points placed on the printed circuit board. All sensor heads have a standard 12 mm diameter and are provided with two o-rings (Parker 12-2) for sealing.
Copyright statement
Copyright @ 1982 – 2015 IDRONAUT S.r.l. - OCEAN SEVEN and IDRONAUT are registered trademarks of IDRONAUT S.r.l. All rights reserved.
Other products and services mentioned in this document are identified by the trademarks or service marks of their respective companies or organizations. No part of this Operator’s Manual, or any software included with it, may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, including photocopying, electronic, mechanical, recording or otherwise, without the prior written permission of the copyright holder.
IDRONAUT S.r.l. provides this document as it is without warranty of any kind either expressed or implied including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose.
IDRONAUT S.r.l. may make changes of improvements in the equipment, software, firmware, or specifications described in this document at any time and without notice. These changes may be incorporated in new releases of this document. This document may contain technical inaccuracies or typographical errors.
IDRONAUT S.r.l. waives responsibility of any labour, materials, or costs incurred by any person or party as a result of using this document or the equipment described in this document.
IDRONAUT S.r.l. shall not be liable for any damages (including, but not limited to, consequential, indirect or incidental, special damages, or loss of profits or data) even if they were foreseeable and IDRONAUT S.r.l. has been informed of their potential occurrence arising out of or in connection with this document or its use.
IDRONAUT S.r.l. shall not be liable for any damages (including, but not limited to, consequential, indirect or incidental, special damages, or loss of profits or data) even if they were foreseeable and IDRONAUT S.r.l. has been informed of their potential occurrence arising out of or in connection with the use of the equipment described in this document.

Agreement
Object of this agreement is the OCEAN SEVEN 307 OEM SMART LOW POWER CTD SENSORS. IDRONAUT S.r.l. agrees to provide the “OCEAN SEVEN 307 OEM SMART LOW POWER CTD SENSORS”, herebelow identified as “OEM MODULE”, under the terms and conditions of this agreement. The precise terms and conditions follow.

TERMS AND CONDITIONS
The “OEM MODULES” hardware, firmware, sensor and accompanying documentation are protected by European Community copyright law and also by International Treaty provisions. Any use of this equipment or part of this equipment in violation of copyright law or the terms of this agreement will be prosecuted to the best of our ability.

OWNERSHIP
The “OEM MODULE” and each hardware, firmware or sensor are property of IDRONAUT S.R.L. which reserves the rights to use the whole “OEM MODULE”, part of its components specifically developed for the “OEM MODULE” in other IDRONAUT S.r.l. products. The “OEM MODULE” is sold to you for use only under the terms of this Agreement. You acknowledge and agree that the product consists of proprietary, unpublished product of IDRONAUT S.r.l. and any third party licensors, protected under copyright law and trade secret laws. All right, title and interest in and to the “OEM MODULE” are and shall remain with IDRONAUT S.r.l.

WARRANTY
The “OEM MODULE” is covered by a one-year limited warranty that extends to all parts and labour and covers any malfunction that is due to poor workmanship or due to errors in the manufacturing process. The warranty does not cover shortcomings that are due to the design, nor does it cover any form of consequential damage because of errors in the measurements. If there is a problem with your “OEM MODULE”, first try to identify the problem by following the procedure outlined in the troubleshooting section of this manual if any. Please contact your representative or IDRONAUT S.r.l. if the problem is identified as a hardware problem or if you need additional help in identifying the problem. Please make sure to contact IDRONAUT S.r.l. to obtain the relevant instructions before the “OEM MODULE” is returned to IDRONAUT.
For systems under warranty, IDRONAUT S.r.l. will attempt to ship replacement parts before the malfunctioning part is returned. We encourage you to contact us immediately if a problem is detected and we will do our best to minimize the downtime. Every effort has been made to ensure the accuracy of this manual. However, IDRONAUT S.r.l. makes no warranties with respect to this documentation and disclaims any implied warranties of merchantability and fitness for a particular purpose. IDRONAUT S.r.l. shall not be liable for any errors or for incidental or consequential damages in connection with the furnishing, performance or use of this manual or the examples herein. The information in this document is subject to change without notice.

OTHER RESTRICTIONS
You may not reverse engineer, de-compile, or disassemble the “OEM MODULE” hardware, sensor and firmware, except to the extent the foregoing restriction is expressly prohibited by applicable law. IDRONAUT S.r.l. may make changes of improvements in the equipment, hardware, firmware, or specifications described in this document at any time and without notice. These changes may be incorporated in new releases of this document. This document may contain technical inaccuracies or typographical errors.
HIGH RISK ACTIVITIES

The “OEM MODULE” is not fault-tolerant and is not designed, manufactured or intended for use as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of the “OEM MODULE” could lead directly to death, personal injury, or severe physical or environmental damage (“High Risk Activities”). IDRONAUT S.r.l. specifically disclaims any express or implied warranty of fitness for High Risk Activities.

CLEANING INSTRUCTIONS

Before the returned “OEM MODULE” can be serviced, equipment exposed to biological, radioactive, or toxic materials must be cleaned and disinfected. Biological contamination is presumed for any instrument, probe, or other device that has been used with wastewater. Radioactive contamination is presumed for any instrument, probe or other device that has been used near any radioactive source. If a “OEM MODULE”, or other part is returned for service without following the cleaning instructions, and if in our opinion it represents a potential biological or radioactive hazard, our service personnel reserve the right to withhold service until appropriate cleaning, decontamination has been completed.

When service is required, either at the user’s facility or at IDRONAUT, the following steps must be taken to insure the safety of our service personnel.

➢ In a manner appropriate to each device, decontaminate all exposed surfaces, including any containers. 70% isopropyl alcohol or a solution of 1/4 cup bleach to 1-gallon tap water are suitable for most disinfecting. Instruments used with wastewater may be disinfected with 5% Lysol if this is more convenient to the user.
➢ The user shall take normal precautions to prevent radioactive contamination and must use appropriate decontamination procedures should exposure occur. If exposure has occurred, the customer must certify that decontamination has been accomplished and that no radioactivity is detectable by survey equipment.
➢ Any product being returned to the IDRONAUT S.r.l. Laboratory for service or repair should be packed securely to prevent damage.
➢ Cleaning must be completed on any product before returning it to IDRONAUT S.r.l.

DISPOSAL OF WASTE EQUIPMENT BY USERS IN THE EUROPEAN UNION

The recycling bin symbol on the product or on its packaging indicates that this product must not be disposed of with your other waste. It is your responsibility to dispose of your waste equipment by handling it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city office, your waste disposal service.
1. INTRODUCTION

The OCEAN SEVEN 307 CTD digital OEM modules make it easy to interface the full ocean IDRONAUT Conductivity, Temperature and Pressure sensors with third-party equipment like data loggers, via the built-in RS485 digital interface and a simple communication protocol. The modules have high-accuracy, high-resolution preamplifiers and the processing power needed to provide, in real time through the RS485 interface, the digital output in engineering units.

The module preamplifiers are temperature compensated, thus further enhancing the measurement accuracy. The modules can be connected together to create an “RS485” network of intelligent sensors.

Four different OEM modules are available:

- Conductivity.
- Temperature.
- Combined pressure and temperature.
- High precision 0.01% pressure.

1.1. RS485 INTERFACE

The physical connection is provided by the RS485 serial interface. This guarantees good interference immunity and enables a flexible bus structure, i.e. several OEM modules can be managed as slaves by a single master. Five different signals and wires are used to integrate the OEM module with a data logger or a personal computer. Two of them: GND and VDC+ are used to give the power supply voltage to the module; two signals (RS485 A, RS485 B) are used to communicate with the module and one signal can be used to switch ON/OFF the module electronics.

In order to operate several OEM modules at one serial interface, they are simply all connected in parallel (RS485 A, RS485 B, GND and +Vcc). Before incorporating the OEM module into the bus, each OEM module must be configured using a different address.

It is possible to configure a network with a maximum of 9 OEM modules. The connection must correspond to “EIA RS485” specification. The MAX3471 RS485 driver is used in the OEM modules. This driver is slew-rate limited. A 4K7 OHM bias resistor is provided in the OEM module electronics. Voltage protection is installed on both lines (RS485 A and RS485 B) in the driver. The common mode voltage relative to GND is –7V ... + 10 V. This voltage must not be exceeded in any circumstance.

Data is transmitted serially via the bus.

The following formats apply:

- 1 start bit.
- 8 data bit.
- 1 stop bit.
- No Parity.
- 38400 baud.

This results in 10 bits per transmission byte.
1.2. **OEM MODULE WIRING**

The OS307 OEM modules come complete with a wiring to power and communicate with the module.

*AMP MODU-II 4x2 female connector (AMP 280365):* (1)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Colour</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Black</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>Red</td>
<td>VDD</td>
</tr>
<tr>
<td>4</td>
<td>Violet</td>
<td>RS485 A</td>
</tr>
<tr>
<td>5</td>
<td>Green</td>
<td>RS485 B</td>
</tr>
<tr>
<td>8</td>
<td>Yellow</td>
<td>Power inhibits (CMOS input max 1mA@5VDC) (2)</td>
</tr>
<tr>
<td>3, 6, 7</td>
<td></td>
<td>unused.</td>
</tr>
</tbody>
</table>

(1) Mating connector: “AMP 280631”.

(2) Tie it to ground or leave disconnected to switch off the module (internally pulled down). Connect to a +5V 1mA maximum to switch on the module.

1.3. **EMC/EMI**

The OS307 OEM modules have been designed to respect the common rules about the electromagnetic compatibility and to reduce the electromagnetic emissions to the minimum. Do not expose the OEM modules to excessive electromagnetic radiations to avoid the decay of performance or malfunction of the OEM modules.

1.4. **OEM MODULE FIRMWARE**

The description of the OEM module operations follows.

1.4.1. **Firmware**

The OS307 OEM modules are managed by a dedicated firmware, which takes care to acquire, process and transmit the readings from the sensors in real time or when interrogated.

Moreover, through dedicated commands and functions, the management firmware allows the configuration of the working parameters and calibration coefficients.

Communication with the OEM modules is managed by a dedicated communication protocol (see the below description and attached document).

1.4.2. **Data processing**

The OS307 OEM module firmware processes the sensor readings and transmits acquired data through the RS485 serial interface. If the module is properly configured, acquired data is converted into engineering units by means of a 2nd order polynomial interpolation before the transmission. A dedicated algorithm, if configured, thermally compensates the sensor electronic pre-amplifier by reading the electronic board temperature in real time.
1.4.3. **Operations**

Once switched on, the OEM module waits for communications from the host controller monitoring the RS485 communications. Each module has its own address and, thanks to the RS485 interface, more than one module can be controlled from a single host to create a network of interconnected sensors. If a valid address is recognised, the OEM module starts to communicate with the host answering the received commands.
2. **CONDUCTIVITY MODULE**

A dedicated high-accuracy preamplifier and associated 18-bit analogue to digital converter interface the IDRONAUT 7-ring conductivity cell. The preamplifier does not contain any electronic adjustment (trim pot) and uses high-stability resistors 0.05% 1ppm instead and a sophisticated data processing algorithm.

The firmware automatically compensates for any thermal drift of the module electronics and calculates the conductivity value in mS/cm in real time.

Measurement specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Initial Accuracy</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conductivity</td>
<td>0..90 mS/cm(*)</td>
<td>± 0.003 mS/cm</td>
<td>0.0003 mS/cm</td>
</tr>
</tbody>
</table>

(*) By reducing the range to 0..70 mS/cm, the resolution becomes 0.0002

2.1. **ELECTRONIC SPECIFICATIONS**

- **Real-time data output rate:** 4 Hz.
- **Interface:** RS485.
- **A/D Converter:** 18-bit SAR.
- **Communication protocol:** SSP (Simple Sensor Protocol).
- **Power supply:**
  - **Voltage:** 3.0..14VDC +/- 10%, nominal 3.6VDC
  - **Run:** 30 mA.
- **Operating temperature:** -1..+70 °C.

2.2. **PHYSICAL CHARACTERISTICS**

- **Dimensions (LxWxH):** 60x35x30 mm.
- **Holding:** 1 x 2mm insulated hole.
- **Weight:** 0.045 kg.
- **Connector:** 10x2-pin female SAMTEC CLT-110-02-G-D-A, mating connector male SAMTEC TMMH-110-04-G-DV-A\(^{(1)}\)

- **PCB Material:** glass reinforced fibre, thickness 1.6 mm and 4 layers with solder resist and silkscreen.

\(^{(1)}\) A wiring ending with an 8-pin AMP MODU-II connector is provided instead. The AMP MODU-II mating connector and contact are provided.

2.3. **GROUND CONNECTION AND SHIELDING OF THE CONDUCTIVITY MODULE**

The conductivity sensor, when immersed in water through its external rings, creates a direct connection between the OEM Module electronic ground and the seawater. Therefore, due to the lack of galvanic insulation, the power supply ground is directly
connected with the water when the conductivity sensor is immersed. It is therefore important to avoid grounds loop or stray currents in the proximity of the sensor to avoid noise in the conductivity measurements.

2.4. **THE SEVEN-RING CONDUCTIVITY SENSOR**

The conductivity sensor is a unique flow-through self-flushed cell with seven platinum ring electrodes. The central ring is excited with alternate current flowing to both the outermost rings. The two adjacent pairs of rings sense the relative drop in voltage due to the electrical conductivity of the measured water. The outermost pair of rings is grounded to shield the measuring cell from any outside electrical interference. The cell is mounted in a special cylindrical plastic body, which guarantees thermic insulation and is filled with silicone oil and provided with a rubber bellow to achieve pressure compensation. The conductivity sensor has the advantage that it can be used in both clean and dirty water without the fear of contamination. Should electrode contamination occur, they can be easily cleaned (even with up to 30% hydrochloric acid) without affecting its performance or requiring re-calibration. Because of its big internal diameter and short length, the cell does not need a pump, as it is easily flushed during profiles. Time constant of the conductivity sensor is 50 ms, at 1 meter per second water flow.

Measurement cell: 7 platinum rings deposited inside a quartz cell, diameter 8 mm, length 45 mm.

Max pressure: 700 bar.

Sensor body: black plastic and titanium.

Compensation: automatic compensation of the pressure and thermal effect on the cell geometry is performed by the acquisition software.

Calibration frequency: yearly.

Maintenance: cleaning using liquid soap.
3. **TEMPERATURE MODULE**

A dedicated high-accuracy preamplifier and associated 24-bit delta sigma analogue to digital converter interface the Pt-100 IDRONAUT temperature. The preamplifier does not contain any electronic adjustment (trimpot) and uses high stability VISHAY resistors, 0.05% 1ppm as a reference. The OEM module firmware automatically compensates for any thermal drift of the module electronics and calculates the temperature value in °C in real time. Three different ranges and accuracies are foreseen. The standard module is calibrated for the first measuring range only. Calibration in the range +40..+105 must be expressly requested.

**Measurement specifications**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Initial Accuracy</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>-5..+40 °C</td>
<td>± 0.003 °C</td>
<td>0.001 °C</td>
</tr>
<tr>
<td></td>
<td>+40..+105 °C</td>
<td>± 0.030 °C</td>
<td>0.001 °C</td>
</tr>
</tbody>
</table>

3.1. **ELECTRONIC SPECIFICATIONS**

- **Real-time data output rate:** 4 Hz.
- **Interface:** RS485.
- **A/D Converter:** 24-bit DS.
- **Communication protocol:** SSP (Simple Sensor Protocol).
- **Power supply:**
  - **Voltage:** 3.0..14 VDC +/- 10%, nominal 3.6 VDC.
  - **Run:** 30 mA.
- **Operating temperature:** -1..+70 °C.

3.2. **PHYSICAL CHARACTERISTICS**

- **Dimensions (LxWxH):** 50x35x30 mm.
- **Holding:** 2 x 3mm insulated holes.
- **Weight:** 0.045 kg.
- **Connector:** 10x2-pin female SAMTEC CLT-110-02-G-D-A, mating connector male SAMTEC TMMH-110-04-G-DV-A. (1)
- **PCB Material:** glass reinforced fibre, thickness 1.6 mm and 4 layers with solder resist and silkscreen.

(1) A wiring ending with an 8-pin AMP MODU-II connector is provided instead. The AMP MODU-II mating connector and contact are provided.
3.3. **THE TEMPERATURE SENSOR**

The temperature sensor is a platinum resistance thermometer (type Pt 100 ohms at 0°C), fitted on a thin stainless steel housing, able to withstand up to 700 bar. The sensor has a very low response time (50 ms) and a high stability of reading with ageing. The drift of reading (sensor plus associated electronics) is less than 0.0003°C per year.

- **Type:** Pt100@0°C
- **Measurement range:** -5..+105 °C
- **Maximum pressure:** 700 bar
- **Sensor body:** AISI 316L
- **Calibration frequency:** yearly
- **Compensation:** none.
- **Maintenance:** none.
4. **COMBINED PRESSURE AND TEMPERATURE MODULE**

The combined module contains two high-accuracy preamplifiers associated with two 24-bit delta sigma analogue to digital converters interfacing a Pt-100 and pressure transducer. Both preamplifiers do not contain any electronic adjustment (trimpot) and use high-stability VISHAY resistors, 0.05% 1ppm as reference. The OEM module firmware automatically compensates for any thermal drift of the module electronics and calculates the temperature in °C and the pressure in dbar in real time. Three different ranges and accuracies are foreseen by the temperature preamplifier; however, the standard module is calibrated for the first measuring range only. Calibration in the range +40..+105 must be expressly requested. Pressure transducers having different full-scale values are available and can be interfaced by the OEM module (see the below pressure sensor specifications).

**Measurement specifications**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Initial Accuracy</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure</td>
<td>0..1000*dbar</td>
<td>± 0.05 % F.S.</td>
<td>0.002 % F.S.</td>
</tr>
<tr>
<td>Temperature</td>
<td>-5..+ 40 °C</td>
<td>0.003 °C</td>
<td>0.001 °C</td>
</tr>
<tr>
<td></td>
<td>+40..+105 °C</td>
<td>0.030 °C</td>
<td>0.001 °C</td>
</tr>
</tbody>
</table>

- other standard pressure transducers immediately available have: 10, 40, 100, 200, 500, 2000, 4000, 6000, 10000 dbar ranges.

4.1. **ELECTRONIC SPECIFICATIONS**

- Real-time data output rate: 4 Hz.
- Interface: RS485.
- A/D Converter: 2x 24-bit DS.
- Power supply:
  - Voltage: 3.0..14 VDC +/- 10%, nominal 3.6 VDC.
  - Run: 30 mA.
- Operating temperature: -1..+70 °C.

4.2. **PHYSICAL CHARACTERISTICS**

- Dimensions (LxWxH): 50x35x30 mm.
- Holding: 2 x 3mm insulated holes.
- Weight: 0.045 kg.
- PCB Material: glass reinforced fibre, thickness 1.6 mm and 4 layers with solder resist and silkscreen.

(1) A wiring ending with an 8-pin AMP MODU-II connector is provided instead. The AMP MODU-II mating connector and contact are provided.
4.3. **PRESSURE SENSOR**

The pressure sensor is a high-quality strain gauge, centrally mounted on the probe base, capable of generating a linear signal output, thus giving a resolution of 0.03% over the whole measuring range of 0 - 10000 dbar.

- **Type:** strain gauge
- **Response time:** 50 ms @1 m/s
- **Measurement bridge resistance:** @ 25°C Ω 3500 ± 20%
- **Excitation current:** 0.6 mA
- **Insulation:** @ 50 VCC MΩ 100
- **Operating temperature:** °C -30…100
- **Sensor body:** AISI 316 L
- **Compensation:** automatic compensation for temperature variations; not compensated for the barometric pressure variations.
- **Calibration frequency:** yearly.
- **Maintenance:** offset calibration in air.

4.4. **THE TEMPERATURE SENSOR**

The temperature sensor is a platinum resistance thermometer (type Pt 100 ohms at 0°C), fitted on a thin stainless steel housing, able to withstand up to 700 bar. The sensor has a very low response time (50 ms) and a high stability of reading with ageing. The drift of reading (sensor plus associated electronics) is less than 0.0003° C per year.

- **Type:** Pt100@0°C
- **Measurement range:** -5..+105 °C
- **Maximum pressure:** 700 bar
- **Sensor body:** AISI 316L
- **Calibration frequency:** yearly
- **Compensation:** none.
- **Maintenance:** none.
5. **HIGH PRECISION PRESSURE MODULE**

The pressure transducers cover all pressure ranges from 100 mbar to 1000 bar. A high-sensitivity piezo-resistive silicon chip is used for pressure sensing. The chip is protected against ambient influences by a stainless steel housing sealed with a concentrically corrugated diaphragm. The housing is filled with silicone oil so as to ensure the transfer of the pressure from the diaphragm to the sensing component. All metal parts in contact with the pressure media are made of stainless steel AISI316L. The fully welded housing is vacuum-tight. Each pressure transducer is subject to comprehensive tests as to its pressure response and temperature characteristic, and is delivered with an individual calibration certificate stating the characteristics as well as the results of all tests that were performed.

**Measurement specification**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Initial Accuracy</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure</td>
<td>0..1000* bar</td>
<td>± 0.01 % F.S.</td>
<td>0.001 % F.S.</td>
</tr>
</tbody>
</table>

*for the available ranges, please see below.

5.1. **TECHNICAL SPECIFICATIONS**

- **Available ranges:**
  - 0.8...12 bar
  - 3 bar
  - 10 bar
  - 30 bar
  - 100 bar
  - 300 bar
  - 1000 bar

- **Overpressure:**
  - 2 bar
  - 5 bar
  - 20 bar
  - 60 bar
  - 200 bar
  - 400 bar
  - 1000 bar

- **Output:**
  - RS 485

- **Supply (V):**
  - 8...28 Vcc

- **Precision:**
  - 0.01 %FS

- **Output Rate:**
  - 400 Hz

- **Resolution:**
  - 0.002 %FS

- **Insulation:**
  - 100 Mohm / 50 V

- **Pressure Endurance:**
  - 10 Million Pressure Cycles 0...100 %FS at 25 °C

- **Material in Contact with Media:**
  - HASTELLOY

- **Connector & wiring:**
  - Molex Milli-Grid 2 mm.

5.2. **ACCURACY AND PRECISION**

“Accuracy” is an absolute term, “Precision” a relative term. Deadweight testers are primary standards for pressure, where the pressure is defined by the primary values of mass, length and time. Higher-class primary standards in national laboratories indicate the uncertainty of their pressure references with 70 to 90 ppM or close to 0.01%. Commercial deadweight testers used to calibrate the transmitters indicate an uncertainty or accuracy of 0.025 %. Below these levels, expression “Precision” is the ability of a pressure transmitter to be at each pressure point within 0.01 %FS relative to these commercial standards.
5.3. **POLYNOMIAL COMPENSATION**

The OEM module uses a mathematical model to derive the precise pressure value (P) from the signals measured by the pressure sensor (S) and the internal temperature sensor (T). The microprocessor in the transmitter calculates P using the following polynomial:

\[ P(S,T) = A(T).S^0 + B(T).S^1 + C(T).S^2 + D(T).S^3 \]

With the following coefficients A(T)...D(T) depending on the temperature:

\[
\begin{align*}
    A(T) &= A_0 \cdot T^0 + A_1 \cdot T^1 + A_2 \cdot T^2 + A_3 \cdot T^3 \\
    B(T) &= B_0 \cdot T^0 + B_1 \cdot T^1 + B_2 \cdot T^2 + B_3 \cdot T^3 \\
    C(T) &= C_0 \cdot T^0 + C_1 \cdot T^1 + C_2 \cdot T^2 + C_3 \cdot T^3 \\
    D(T) &= D_0 \cdot T^0 + D_1 \cdot T^1 + D_2 \cdot T^2 + D_3 \cdot T^3
\end{align*}
\]

The OEM module is factory-tested at various levels of pressure and temperature. The corresponding measured values of S, together with the exact pressure and temperature values, allow the coefficients A0...D3 to be calculated. These are written into the EEPROM of the microprocessor. When the pressure OEM Module is interrogated, the microprocessor measures the signals (S) and (T), calculates the coefficients according to the temperature and produces the exact pressure value by solving the P(S,T) equation. Calculations and conversions are performed 400 times per second.

5.4. **COMMUNICATION PROTOCOL**

The High-precision module is interfaced through a dedicated protocol based on MODBUS, but incorporates optimised functions for the OEM module. The complete description of the communication protocol is shown in a dedicated document.
6. **INSTALLATION AND START-UP**

Unpacking, installation and start-up procedures are described in this section.

6.1. **INSTALLATION**

The OEM module and its associated sensors come complete with wiring and connectors. The connector is marked to facilitate the sensor installation on the electronic module. Please always connect the sensor to the electronic module before applying power.

The module is shipped with a spare connector and contacts (see below) to build a custom cable for the connection with an external data logger.

6.2. **ITERM PROGRAM INSTALLATION**

Please copy the content of the ITERM folder from the CD-ROM to your PC hard disk. A short cut on the desktop can be created to simplify the ITERM launch. At the first run, ITERM must be properly configured to meet the communication criteria of the OEM module, which are: 38400 baud, 8 data bits, 1 stop bit, no parity, DIGITAL VT100 Terminal emulation, no hand-checking.

The ITERM folder on CD-ROM contains the program and some text files which allow the operator to easily exercise communications with the OEM module.

**Note:**

*Please be aware that the predefined command files imply that the OEM module address is the default value: 1.*

*In case the OEM module address has been modified, the files must be edited to modify the address according to the OEM module address.*

6.3. **POWER SUPPLY**

Do not power the module using noisy AC/DC power supply. If the OEM module is directly connected to a personal computer, we suggest using a galvanic insulation between the OEM module RS485 and the PC interface.

6.4. **HOW TO OPERATE THE OEM MODULE**

The OEM module can be operated through the ITERM software per Windows; the communication parameters of ITERM must be set to: 38400 baud, 8 data bits, 1 stop bit, no parity, DIGITAL VT100 Terminal emulation.

The communication with the OEM module is carried out using an RS485 interface. Therefore, a special adapter to convert the USB or the RS232C standard PC interfaces into RS485 is needed. Furthermore, a stabilized DC power supply regulated to generate 5VDC must be connected to the electronic module power supply wires.
**Note**
Exceeding the nominal power supply by more than 10% will cause the destruction of the OEM module electronics. There is no protection against excessive power supply voltage.

When the power is applied, the OEM module wakes up and starts in “VERBOSE” mode (see description at section 7.4) transmitting the start-up messages (see below). Afterwards, the OEM module waits for the commands according to the communication protocol rules. The commands can be manually sent by the operator or by using the predefined command files distributed with the ITERM program. In the latter case, the “File-&gt;Transfer” function of ITERM must be used to send the command file to the OEM module.

**Note**
We suggest running the ITERM program first, setting it up, if needed, and then applying the power to the OEM module.

### 6.4.1. Verbose vs Non-Verbose
If the OEM module has been reverted to “NON-VERBOSE” mode, the only way to return its operating mode to “VERBOSE” mode is to use the dedicated command message present in the ITERM folder and send it using ITERM. The operating mode is stored in the internal non-volatile configuration memory and the chosen operating mode is kept by the OEM module across ON/OFF cycles.

**Note:**
Please be aware that the predefined command files imply that the OEM module address is the default “1”. In case the OEM module address has been modified, the files must be edited to modify the address according to the OEM module address.

### 6.5. OEM MODULE START-UP PROCEDURE
Once the OEM module is connected to the ITERM and wakes up, it sends the following start-up message:

```
OS307 OEM Temperature/Pressure Module
SSP[1]|0612030| - Fw:1.5 Hw:0.2 Feb/2015
CMD[@1]>
```

Now, the OEM module is ready and waits for commands from operator.

### 6.6. INSTALLATION OF OEM MODULE IN AN RS485 NETWORK OF SENSORS
At first, the OEM module start-up runs in “VERBOSE” mode. In case the OEM module is being part of a network of intelligent sensors, it is mandatory to assign it an “unused” address and revert its operation to “NON-VERBOSE” mode! The operating mode is kept stored in the internal configuration memory and remains valid across ON/OFF cycles. Operating the OEM module in “VERBOSE” mode, while connected to an RS485 sensor network, may cause communication problems to sensor network.
7. **OEM MODULE COMMUNICATION PROTOCOL**

The Simple Sensor Protocol, formerly SSP, has been developed to allow communications between OEM modules and a main control unit. The sensor network is built up using the half-duplex RS485 hardware protocol. The networked units share the Rx/Tx communications lines as foreseen by the EIA 485 standard. The SSP is a half-duplex protocol which implies that the OEM modules always operate in «slave» mode waiting for communication from the main control unit. This means that the OEM modules do nothing but wait while spying the network on-going communications. Only if the command message contains the OEM module address, it answers accordingly. The SSP protocol uses plain ASCII characters only to communicate. Two different types of messages are foreseen by the protocol: **command** and **answer**.

The SSP communication protocol is present in the following OEM Modules:

- Conductivity
- Temperature
- Pressure and temperature combined

### 7.1. COMMAND MESSAGE STRUCTURE

Command messages sent by the control station have the following structure:

<table>
<thead>
<tr>
<th>Attention</th>
<th>Address</th>
<th>Cmd. Identification</th>
<th>Payload</th>
<th>Terminator</th>
</tr>
</thead>
<tbody>
<tr>
<td>8bit – 1Byte</td>
<td>8bit – 1Byte</td>
<td>8bit – 1Byte</td>
<td>8Bit - 128Byte</td>
<td>8bit – 1Byte</td>
</tr>
</tbody>
</table>

- **Attention**
  - One digit 1..9; 0 is reserved for broadcasting messages to address all the sensors connected on the network.
- **Address**
- **Command identification**
  - Single upper case character which identifies the command “A..Z”
- **Payload**
  - Optional. If the command foresees a payload, the maximum length is 128 bytes. Contents of the payload may be separated by a space character.
- **Terminator**
  - `<CR>` 0x0D, 13, character used to terminate the command messages.

**i.e.** #1R1<CR> Command to carry out a reading from the sensor

### 7.2. ANSWER MESSAGE STRUCTURE

Answer messages sent by the OEM module to the control station have the following structure:
### 7.3. **COMMUNICATION PROTOCOL COMMANDS**

The complete description of the SSP commands used by the OEM modules is described in the attached document “Simple Sensor Protocol”.

### 7.4. **COMMUNICATION PROTOCOL MODE**

The SSP communication protocol foresees two different operating modes: “VERBOSE” and “NON-VERBOSE”.

The “NON-VERBOSE” mode is typically dedicated to the interfacing of the OEM module from data logger or electronic devices, while the “VERBOSE” mode is a slow human oriented interface.

The “VERBOSE” mode foresees that the OEM module transmits “Diagnostic” plain ASCII messages not foreseen by the communication protocol, but which help the operator to understand the OEM module behavior and running activities.

Associated with the operating mode, there are two different communication time-outs. A fast time-out applies whenever the OEM module is running in “NON-VERBOSE” mode and a very slow time-out whenever the OEM module is running in “VERBOSE” mode. They are respectively: Verbose = 30s and Non-verbose = 30ms.
8. **ITERM PROGRAMME**

The aim of the ITERM programme is to provide a simple and reliable tool that IDRONAUT customers can freely use to communicate with their products, like the OEM Module. ITERM does not need any special installation procedure.

8.1. **DISTRIBUTED FILES**

ITERM can be freely uploaded from the IDRONAUT web site download area in a self-extracting package, which contains the following files:

- **ITERM.EXE** Terminal emulation and probe upgrading programme.
- **Iterm.rtf** ITERM programme documentation (Read Only).

8.2. **PROGRAMME MENUS AND FUNCTIONS**

The ITERM Main Menu has the following items: File, Port, Probe, Transfer, and Help. A short description of any menu and function follows.

![ITERM Interface](image)

**File->Exit**

It exits from the programme closing the communication port and any open file.
**Edit->CopySelectionToClipBoard**
This function copies the selected text to the Windows operating system clipboard buffer.

**Edit->CaptureToFile**
This function captures the characters received and sent through the serial port to a text file. The operator can select the file name and folder. Invoking this function, once ITERM is capturing, the character stops capturing and returns to the standard operations.

**Port->Set parameters**
This function allows the operator to set and define the communication port parameters. Default values for the OEM Modules are: 38400 bps, 8bit data, 1stop bit, No parity, Hardware hand checking (CTS/RTS, DTR/DSR).

**Port->Close**
It closes the open communication port.

**Probe->Identify**
This function is not available on the OEM Modules.

**Probe->Upgrade**
This function is not available on the OEM Modules.

**Probe->Set Time**
This function is not available on the OEM Modules.

**Probe->Upload data**
This function is not available on the OEM Modules.

**Probe->Unattended cast**
This function is not available on the OEM Modules.

**Aspect->Font**
This function allows the operator to decide the type of font to use to show messages on the terminal window.

**Aspect->Colour**
This function allows the operator to select the foreground and background colours among a list of possible choices.

**Transfer->SendTextFile**
This function allows the operator to transfer a text file to the OEM module connected through the serial port.

**Help->Contents**
It shows the help file.

**Help->About**
It shows some notice about ITERM programme release.
8.3. **TOOLBAR**

On the program toolbar, there are the short cuts to the programme functions.

- Disconnects the communication port, freeing the port for other programmes or allowing the modification of communication port parameter.

This function is not available on the OEM Modules.

This function is not available on the OEM Modules.

This function is not available on the OEM Modules.

Accesses the set-up of communication port parameter.

Captures transmissions from the connected probe and keyboard typing and storing them in the selected text file. A red cross appears on the icon when running. Pressing it once stops the capture and closes the text file.

8.4. **START-UP SWITCHES**

It is possible to customize the programme at the start-up by adding the following switches to the programme properties:

- `- p x` Where x represents the communication port number 1..8
- `- b bps` Where bps represents the communication speed and can be 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200.
9. **OEM307- PINOUTS**

Description of the OEM307 Temperature/Pressure and Conductivity module mating connector.

TMMH-110-04-G-DV-A

<table>
<thead>
<tr>
<th>PIN</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
</tr>
<tr>
<td>3</td>
<td>16bit Analogue input #6</td>
</tr>
<tr>
<td>4</td>
<td>16bit Analogue input #5</td>
</tr>
<tr>
<td>5</td>
<td>16bit Analogue input #4</td>
</tr>
<tr>
<td>6</td>
<td>16bit Analogue input #3</td>
</tr>
<tr>
<td>7</td>
<td>16bit Analogue input #2</td>
</tr>
<tr>
<td>8</td>
<td>16bit Analogue input #1</td>
</tr>
<tr>
<td>9</td>
<td>I/O pin reserved – not used by OEM modules</td>
</tr>
<tr>
<td>10</td>
<td>V+ 3.3 VDC</td>
</tr>
<tr>
<td>11</td>
<td>V+ 3.3 VDC</td>
</tr>
<tr>
<td>12</td>
<td>I/O pin reserved – not used by OEM modules</td>
</tr>
<tr>
<td>13</td>
<td>I/O pin reserved – not used by OEM modules</td>
</tr>
<tr>
<td>14</td>
<td>RS485 A+</td>
</tr>
<tr>
<td>15</td>
<td>RS485 B+</td>
</tr>
<tr>
<td>16</td>
<td>ON/OFF Signal</td>
</tr>
<tr>
<td>17</td>
<td>I/O pin reserved – not used by OEM modules</td>
</tr>
<tr>
<td>18</td>
<td>I/O pin reserved – not used by OEM modules</td>
</tr>
<tr>
<td>19</td>
<td>GND</td>
</tr>
<tr>
<td>20</td>
<td>GND</td>
</tr>
</tbody>
</table>